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Important Notice about Customer Self-Repair Parts

CAUTION: Your computer includes Customer Self-Repair parts and parts that should only be
accessed by an authorized service provider. See Chapter 5, "Removal and replacement procedures for
Customer Self-Repair parts," for details. Accessing parts described in Chapter 6, "Removal and
replacement procedures for Authorized Service Provider only parts," can damage the computer or void
your warranty.
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Safety warning notice

WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do not
place the device directly on your lap or obstruct the device air vents. Use the device only on a hard, flat
surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft surface,
such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact
the skin or a soft surface, such as pillows or rugs or clothing, during operation. The device and the AC
adapter comply with the user-accessible surface temperature limits defined by the International
Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description

Product Name HP EliteBook Revolve 810 G2

Processors ● Intel® Dual Core® i7-4600U 2.1-GHz processor (turbo up to 3.3-GHz), 1600-MHz
FSB, 4-MB L3 cache, 15 W

● Intel Dual Core i5-4200U 1.6-GHz processor (turbo up to 2.6-GHz), 1600-MHz FSB, 3-
MB L3 cache, 15 W

● Intel Dual Core i5-4300U 1.9-GHz processor (turbo up to 2.90-GHz), 1600-MHz FSB,
3-MB L3 cache, 15 W

● Intel Dual Core i3-4010U 1.7-GHz processor, 1600-MHz front-side bus (FSB), 3 MB L3
cache, 15 W

Chipset Mobile Intel QM87 PCH chipset

Graphics Intel UMA Graphics with shared video memory

Support for dual-display ports through the dock

Panel 11.6-in high-definition (HD), light-emitting diode (LED), AntiGlare (AG), UWVA (1366×768),
ultraslim display with webcam and microphone

Touchscreen enabled. Touch Controller: Atmel, 2952T1

Typical brightness: 400 nits

Memory One customer-accessible/upgradable memory module slot + 4-GB on the system board

Support for DDR3L PC-3 12800 (1600-MHz)

Support for 12288-MB of system RAM in the following configurations:

● 12288-MB (8192-MB memory module + 4096-MB on system board)

● 8192-MB (4096-MB memory module + 4096-MB on system board)

● 4096-MB (4096-MB on system board)

Solid-state drive Serial ATA III

Support for the following single solid-state drive configurations:

● 256-GB M.2

● 128-GB M.2

● 180-GB M.2

Audio and video DTS Studio sound

Integrated dual-array microphones

Stereo speakers (2)

Camera 720 HD

Ethernet Integrated Intel 82579LM 10/100/1000 network interface card (NIC)
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Category Description

Wireless Integrated wireless personal area network (WPAN) option supported only through
combination module

 Two WLAN antennas built into display assembly

 Integrated wireless local area network (WLAN) options by way of wireless module

Support for the following WLAN modules:

● Intel Dual Band Wireless-AC 7260 802.11 ac (2x2) WiFi + BT 4.0 combo

● Intel Dual Band Wireless-N 7260AN 802.11 a/b/g/n (2x2) WiFi + BT 4.0 combo

● Intel Dual Band Wireless-N 7260NB 802.11 a/b/g/n (2x2) WiFi

 Support for no WLAN/Bluetooth option

 Two WWAN antennas built into display assembly

 Integrated wireless wide area network (WWAN) options by way of wireless module

Support for the following WWAN modules:

● HP hs3110 HSPA+ Mobile Broadband

● HP lt4111 LTE/EV-DO/HSPA+ Mobile Broadband Module (for use in the United States)

● HP lt4112 LTE/HSPA+ Mobile Broadband Module (for use in Europe and Asia Pacific)

 WWAN secured by micro-SIM

 Support for no WWAN option

 Support for WWAN after market option

 Integrated near field communication (NFC) module and antenna

External media cards Micro-Secure Digital slot

 Combo Headphone/MIC jack side docking connector

Ports ● AC adapter

● Audio-in (mono microphone)/audio-out (stereo headphone) combination

● DisplayPort 1.2

● Docking

● RJ-45 (Ethernet)

● USB 3.0 (2), (1 charging port)

Sensors ● Accelerometer

● ALS

● Compass

● Gyro

● NFC with Secure Element

● Proximity (SAR)

Docking Quest 1.0 & Quest 2.0
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Category Description

Keyboard/pointing
devices

Full-size, backlit, spill-reistant keyboard with DuraKeys and active pen

Gesture support: MultiTouch gestures enabled, two-finger scrolling, and pinch-
zoom as default

Taps enabled by default

Support for ClickPad with image sensor, scroll, pinch, zoom, rotate, and 3-finger flick)

Multitouch gestures enabled

Power requirements Support for 65-W HP Smart AC adapter (RC, V, EM, 3-wire) and 45-W HP Smart AC
adapter (RC, V, non-PFC, 3-wire)

Power cord is configurable; either 3.2 feet or 6 feet (1.0 or 1.8 meter)

For specific power cord options, see Miscellaneous parts on page 17.

 Support for 6-cell, 44-Wh, 1.98-Ah, Li-ion battery (Li-ion)

Security ● Support for security cable lock

● Support for Trusted Platfom Module (TPM) 1.2 Enhanced Drive Lock

● HP ProtectTools (Limited Suite)

● HP Power Assistant

● Preboot Authentication (Password)

Operating system Preinstalled:

● Windows 8.1 CH 64-bit (only available in China)

● Windows 8.1 EM 64-bit

● Windows 8.1 ML 64-bit

● Windows 8.1 Professional 64-bit

● Windows 8.1 Professional 64-bit DPK with Windows 7 Pro image (not available in
China or Japan)

● Windows 7 Professional 64-bit

● Windows 7 Home Premium 64-bit

● FreeDos 2.0

Serviceability End user replaceable part:

● AC adapter

● Primary battery

● DIMM memory

● M.2 solid-state drive

● Docking Station

● WLAN module

● WWAN module
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CAUTION: To prevent damage to the display hinges, when in notebook configuration, do not rotate
the display counterclockwise, and do not force the rotating action.

To change your notebook to a tablet

1. Rotate the display clockwise 180 degrees until the display faces backwards.

2. Lower the display over the keyboard.

To change the tablet back into a notebook, reverse these steps.

Display

Component  Description

(1) WWAN antennas (2)* Send and receive wireless signals to communicate with
wireless wide area networks (WWAN).

(2) Ambient light sensor Brightens or dims the display in response to
ambient light.

(3) WLAN antennas (2)* Send and receive wireless signals to communicate with
wireless local area networks (WLAN).

(4) Internal microphones (2) Record sound.

(5) Webcam light On: The webcam is in use.

Display 5



Component  Description

(6) Webcam Records video and captures photographs. Some models
allow you to video conference and chat online using
streaming video.

(7) Windows Home button Returns you to the Start screen.

*The antennas are not visible on the outside of the computer. For optimal transmission, keep the areas immediately around the
antennas free from obstructions. To see wireless regulatory notices, see the section of the Regulatory, Safety, and Environmental
Notices that applies to your country or region. To access the user guides, select the HP Support Assistant app on the Start
screen, select My computer, and then select User guides.

Right side

Component   Description

(1)  Power button Turns power on and off.

(2) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state,
a powersaving state. The computer shuts
off power to the display and other
unneeded components.

● The computer is off or in Hibernation.
Hibernation is a power-saving state that
uses the least amount of power.

(3)  Rotation lock Locks screen orientation in either Landscape or
Portrait mode.

NOTE: When you move between notebook
and tablet configuration, the computer screen
will automatically change to vertical or
horizontal. To lock the current screen
orientation, slide the screen orientation button.

(4)  Volume button Lowers the volume.

(5)  Volume button Raises the volume.

(6)  Speaker Produces sound.

(7) Memory card reader Reads optional memory cards that store,
manage, share, or access information.
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Component   Description

(8) Audio-out (headphone) jack/Audio-
in (microphone) jack

Connects optional powered stereo speakers,
headphones, earbuds, a headset, or a television
audio cable. Also connects an optional headset
microphone. This jack does not support optional
microphone-only devices.

WARNING! To reduce the risk of personal
injury, adjust the volume before putting on
headphones, earbuds, or a headset. For
additional safety information, see the
Regulatory, Safety, and Environmental
Notices. .

NOTE: When a device is connected to the
jack, the computer speakers are disabled.

NOTE: Be sure that the device cable has a 4-
conductor connector that supports both audio-
out (headphone) and audio-in (microphone).

(9)  Docking port Connects an optional docking device.

Left side
NOTE: Your computer may look slightly different from the illustration in this section.

Component  Description

(1) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(2) Speaker Produces sound.

TouchPad
NOTE: Your computer may look slightly different from the illustration in this section.
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Component  Description

(1) TouchPad on/off button Turns the TouchPad on or off.

(2) TouchPad zone Moves the pointer and selects or activates items on
the screen.

(3) Left TouchPad button Functions like the left button on an external mouse.

(4) Right TouchPad button Functions like the right button on an external mouse.

Lights
NOTE: Your computer may look slightly different from the illustration in this section.

Component   Description

(1)  Caps lock light On: Caps lock is on, which switches the keys to
all capital letters.

(2) Mute light ● Amber: Computer sound is off.

● Off: Computer sound is on.
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Component   Description

(3) Microphone mute light ● Amber: microphone sound is off.

● Off: Microphone is on.

(4) Wireless light ● On: An integrated wireless device, such as
a wireless local area network (WLAN)
device and/or a Bluetooth® device, is on..

NOTE: On some models, the wireless light is
amber when all wireless devices are off.

(5)  Num lock light On: Num lock is on.

(6)  TouchPad light ● On: The TouchPad is off..

● Off: The TouchPad is on.

Keys
NOTE: Your computer may look slightly different from the illustration in this section.

Component   Description

(1)  esc key Displays system information when pressed in
combination with the fn key.

(2)  fn key Executes frequently used system functions when
pressed in combination with a function key, the
num lk key, the esc key, or the b key.

(3) Windows button Displays the Windows Start menu.

(4)  Function keys Execute frequently used system functions when
pressed in combination with the fn key.
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Component   Description

(5)  Embedded numeric keypad When the keypad is turned on, it can be used
like an external numeric keypad.

Each key on the keypad performs the function
indicated by the icon in the upper-right corner of
the key.

(6) Windows application key Displays options for a selected object.
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Bottom
NOTE: Your computer may look slightly different from the illustration in this section.

Component   Description

(1)  Service door Gives access to the hard drive, the wireless LAN
module slot, the WWAN module slot (select
models only), and the memory module slots.

CAUTION: To prevent an unresponsive
system, replace the wireless module only with a
wireless module authorized for use in the
computer by the governmental agency that
regulates wireless devices in your country or
region.

(2)  Vents Enables airflow to cool internal components.

NOTE: The computer fan starts up
automatically to cool internal components and
prevent overheating. It is normal for the internal
fan to cycle on and off during routine operation.

(3) Near Field Communication (NFC)
antenna

Allows you to connect wirelessly with,
communicate with, and transfer data/info to and
from your Near Field Communication (NFC)-
compatible devices.

(4)  Battery bay Holds the battery.

(5) Battery bay cover release latch Releases the battery cover over the battery bay.
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Rear
NOTE: Your computer may look slightly different from the illustration in this section.

Component   Description

(1) RJ-45 (network) jack Connects a network cable.

● Green (left): The network is connected.

● Amber (right): Activity is occurring on the
network.

(2) USB 3.0 ports (1) Connects an optional USB device, such as a
keyboard, mouse, external drive, printer,
scanner or USB hub.Connects an optional USB
device, such as a keyboard, mouse, external
drive, printer, scanner or USB hub.

(3) Security cable slot Attaches an optional security cable to the
computer.

NOTE: The security cable is designed to act
as a deterrent, but it may not prevent the
computer from being mishandled or stolen.

(4) DisplayPort Connects an optional digital display device,
such as a high-performance monitor or
projector.

(5) USB 3.0 charging port Connects an optional USB device, such as a
keyboard, mouse, external drive, printer,
scanner or USB hub. Standard USB ports will not
charge all USB devices or will charge using a
low current. Some USB devices require power
and require you to use a powered port.

NOTE: USB charging ports can also charge
select models of cell phones and MP3 players,
even when the computer is off.

(6)  Power connector Connects an AC adapter.

(7) AC adapter light ● White: The AC adapter is connected and
the battery is charged..

● Amber: The AC adapter is connected and
the battery is charging.

● Off: The computer is using DC power.
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3 Illustrated parts catalog

Service tag
When ordering parts or requesting information, provide the computer serial number and model number
provided on the service tag. It is necessary to remove the battery to obtain these numbers. See Bottom
on page 11 for battery removal instructions.

Item Description Function

(1) Product name This is the product name affixed to the front of
the computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to
each product.

(3) Part number/Product number (p/n) This number provides specific information about
the product's hardware components. The part number
helps a service technician to determine what
components and parts are needed.

(4) Warranty period This number describes the duration of the warranty
period for the computer.

(5) Model description This is the alphanumeric identifier used to locate
documents, drivers, and support for the computer.

Service tag 13
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Item Component Spare part number

(1) Display assembly, 11.6-in, AntiGlare (1366×768), HD, UWVA (includes display
hinge, microphones, webcamera, and Windows button)

753720-001

(2a) Hinge cover (includes hinge cap (2b), WWAN antenna cables and transceivers,
and WWAN antenna cable shield)

753714-001

(3) Keyboard with backlight (includes backlight cable and keyboard cable):

 For use in Belgium 716747-A41

 For use in Brazil 716747-201

 For use in Bulgaria 716747-261

 For use in Canada 716747-DB1

 For use in the Czech Republic and Slovakia 716747-FL1

 For use in Denmark 716747-081

 For use in France 716747-051

 For use in Germany 716747-041

 For use in Greece 716747-151

 For use in Hungary 716747-211

 For use in Iceland 716747-DD1

 For use in India 716747-D61

 For use in Israel 716747-BB1

 For use in Italy 716747-061

 For use in Japan 716747-291

 For use in Latin America 716747-161

 For use in the Netherlands 716747-B31

 For use in Norway 716747-091

 For use in Northwest Africa 716747-FP1

 For use in Portugal 716747-131

 For use in Romania 716747-271

 For use in Russia 716747-251

 For use in Saudi Arabia 716747-171

 For use in Slovenia 716747-BA1

 For use in South Korea 716747-AD1

 For use in Spain 716747-071

 For use in Sweden and Finland 716747-B71

 For use in Switzerland 716747-BG1
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Item Component Spare part number

 For use in Taiwan 716747-AB1

 For use in Thailand 716747-281

 For use in Turkey 716747-141

 For use in the United Kingdom and Singapore 716747-031

 For use in the United States 716747-001

(4) Base enclosure 753721-001

(5) System board (includes processor and replacement thermal material):

 Equipped with an Intel Dual Core iIntel Dual Core i7-4600U 2.1-GHz processor (turbo
up to 3.3-GHz), 1600-MHz FSB, 4- MB L3 cache, 15 W and the Standard operating
system

753726-001

 Equipped with an Intel Dual Core iIntel Dual Core i7-4600U 2.1-GHz processor (turbo
up to 3.3-GHz), 1600-MHz FSB, 4- MB L3 cache, 15 W, and the Windows 8
Standard operating system

753726-501

 Equipped with an Intel Dual Core Intel Dual Core i7-4600U 2.1-GHz processor (turbo
up to 3.3-GHz), 1600-MHz FSB, 4- MB L3 cache, 15 W, and the Windows 8
Professional operating system

753726-601

 Equipped with an Intel Dual Core i5-4300U 1.9-GHz processor (turbo up to 2.90-
GHz), 1600-MHz FSB, 3-MB L3 cache, 15 W, and the Standard operating system

753725-001

 Equipped with an Intel Dual Core i5-4300U 1.9-GHz processor (turbo up to 2.90-
GHz), 1600-MHz FSB, 3-MB L3 cache, 15 W, and the Windows 8 Standard
operating system

753725-501

 Equipped with an Intel Dual Core i5-4300U 1.9-GHz processor (turbo up to 2.90-
GHz), 1600-MHz FSB, 3-MB L3 cache, 15 W, and the Windows 8 Professional
operating system

753725-601

 Equipped with an Intel Dual Core i5-4200U 1.6-GHz processor (turbo up to 2.6-GHz),
1600-MHz FSB, 3- MB L3 cache, 15 W and the Standard operating system

753724-001

 Equipped with an Intel Dual Core i5-4200U 1.6-GHz processor (turbo up to 2.6-GHz),
1600-MHz FSB, 3- MB L3 cache, 15 and the Windows 8 Standard operating system

753724-501

 Equipped with an Intel Dual Core i5-4200U 1.6-GHz processor (turbo up to 2.6-GHz),
1600-MHz FSB, 3- MB L3 cache, 15 and the Windows 8 Professional
operating system

753724-601

 Equipped with an Intel Dual Core i3-4010U 1.7-GHz processor, 1600-MHz front-side
bus (FSB), 3 MB L3 cache, 15 W and the Standard operating system

753723-001

 Equipped with an Intel Dual Core i3-4010U 1.7-GHz processor, 1600-MHz front-side
bus (FSB), 3 MB L3 cache, 15 W and the Windows 8 Standard operating system

753723-501

 Equipped with an Intel Dual Core i3-4010U 1.7-GHz processor, 1600-MHz front-side
bus (FSB), 3 MB L3 cache, 15 W and the Windows 8 Professional operating system

753723-601

(6) Fan/heat sink assembly (includes replacement thermal material) 753716-001

(7) RTC battery (includes cable and double-sided adhesive) 716742-001

(8) Top cover (includes battery release latch, NFC board antenna cable) 753715-001
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Item Component Spare part number

(9) Power Button board (includes cable) 753718-001

(10) Speaker Kit (includes left and right speakers and cables) 753719-001

(11) NFC board (includes cable) 753717-001

(12) Memory module (PC3L, 12800, 1600-MHz):

 8-GB 693374-001

 4-GB 691740-001

(13) Solid-state drive:

 256-GB 753729-001

 128-GB 753728-001

 180-GB 753730-001

(14) WWAN module:

 HP lt4112 LTE/HSPA+ Mobile Broadband Module (Europe and Asia Pacific) 704030-001

 HP lt4111 LTE/EV-DO/HSPA+ Mobile Broadband Module (for use in the United States
and Canada)

740011-001

 HP hs3110 HSPA+ Mobile Broadband 753650-001

(15) WLAN module:

 Intel Dual Band Wireless-N 7260NB 802.11 a/b/g/n (2x2) WiFi 717380-001

 Intel Dual Band Wireless-N 7260AN 802.11 a/b/g/n (2x2) WiFi + BT 4.0 combo 717379-001

 Intel Dual Band Wireless-N 7260AN 802.11 a/b/g/n (2x2) WiFi + BT 4.0 combo
(for use in Indonesia)

747833-001

 Intel Dual Band Wireless-AC 7260 802.11 ac (2x2) WiFi + BT 4.0 combo 710663-001

(16) Service door plastics kit (not illustrated, includes screws and 2 rubber feet) 753713-001

 Plastics/Rubber Kit (not illustrated, includes 4 service door rubber screw covers) 716744-001

(17) 6-cell, 44-Wh, 1.98-Ah, Li-ion battery (includes rubber feet and speaker grilles) 698943-001

Miscellaneous parts 

Component Spare part number

AC adapter:

65-W HP Smart AC adapter (RC, V, EM, 3-wire) 693710-001

45-W HP Smart AC adapter (RC, V, non-PFC, 3-wire) 696694-001

Power cord (3-pin, black, 1.83-m):

For use in Australia 490371-011
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Component Spare part number

For use in Brazil 490371-202

For use in Denmark 490371-081

For use in Europe 490371-021

For use in Israel 490371-BB1

For use in Italy 490371-061

For use in Japan 490371-291

For use in North America 490371-001

For use in the People's Republic China 490371-AA1

For use in South Korea 490371-AD1

For use in Switzerland 490371-111

For use in Taiwan 490371-AB1

For use in Thailand 490371-201

For use in the United Kingdom and Singapore 490371-031

For use in South Africa 490371-AR1

For use in Argentina 490371-D01

For use in India 490371-D61

Screw Kit 753731-001

Sequential part number listing 

Spare part number Description

490371-001 Power cord for use in North America (3-pin, black, 1.83-m)

490371-011 Power cord for use in Australia (3-pin, black, 1.83-m)

490371-021 Power cord for use in Europe (3-pin, black, 1.83-m)

490371-031 Power cord for use in the United Kingdom and Singapore (3-pin, black, 1.83-m)

490371-061 Power cord for use in Italy (3-pin, black, 1.83-m)

490371-081 Power cord for use in Denmark (3-pin, black, 1.83-m)

490371-111 Power cord for use in Switzerland (3-pin, black, 1.83-m)

490371-201 Power cord for use in Thailand (3-pin, black, 1.83-m)

490371-202 Power cord for use in Brazil (3-pin, black, 1.83-m)

490371-291 Power cord for use in Japan (3-pin, black, 1.83-m)

490371-AA1 Power cord for use in the People's Republic of China (3-pin, black, 1.83-m)

18 Chapter 3   Illustrated parts catalog



Spare part number Description

490371-AB1 Power cord for use in Taiwan (3-pin, black, 1.83-m)

490371-AD1 Power cord for use in South Korea (3-pin, black, 1.83-m)

490371-AR1 Power cord for use in South Africa (3-pin, black, 1.83-m)

490371-BB1 Power cord for use in Israel (3-pin, black, 1.83-m)

490371-D01 Power cord for use in Argentina (3-pin, black, 1.83-m)

490371-D61 Power cord for use in India (3-pin, black, 1.83-m)

691740-001 4-GB memory module (PC3L, 12800, 1600-MHz)

693374-001 8-GB memory module (PC3L, 12800, 1600-MHz)

693710-001 65-W HP Smart AC adapter (RC, V, EM, 3-wire)

696694-001 45-W HP Smart AC adapter (RC, V, non-PFC, 3-wire)

698943-001 6-cell, 44-Wh, 1.98-Ah, Li-ion battery (includes rubber feet and speaker grilles)

704030-001 WWAN HP lt4112 LTE/HSPA+ Mobile Broadband Module (Europe and Asia Pacific) 

710663-001 WLAN Intel Dual Band Wireless-AC 7260 802.11 ac (2x2) WiFi + BT 4.0 combo

716742-001 RTC battery

716744-001 Plastics/Rubber Kit (includes 4 service door rubber screw covers)

716747-001 Keyboard with backlight for use in the United States (includes backlight cable and keyboard cable)

716747-031 Keyboard with backlight for use in the United Kingdom and Singapore (includes backlight cable
and keyboard cable)

716747-041 Keyboard with backlight for use in France (includes backlight cable and keyboard cable)

716747-051 Keyboard with backlight for use in Germany (includes backlight cable and keyboard cable)

716747-061 Keyboard with backlight for use in Italy (includes backlight cable and keyboard cable)

716747-071 Keyboard with backlight for use in Spain (includes backlight cable and keyboard cable)

716747-081 Keyboard with backlight for use in Denmark (includes backlight cable and keyboard cable)

716747-091 Keyboard with backlight for use in Norway (includes backlight cable and keyboard cable)

716747-131 Keyboard with backlight for use in Portugal (includes backlight cable and keyboard cable)

716747-141 Keyboard with backlight for use in Turkey (includes backlight cable and keyboard cable)

716747-151 Keyboard with backlight for use in Greece (includes backlight cable and keyboard cable)

716747-161 Keyboard with backlight for use in Latin America (includes backlight cable and keyboard cable)

716747-171 Keyboard with backlight for use in Saudi Arabia (includes backlight cable and keyboard cable)

716747-201 Keyboard with backlight for use in Brazil (includes backlight cable and keyboard cable)

716747-211 Keyboard with backlight for use in Hungary (includes backlight cable and keyboard cable)

716747-251 Keyboard with backlight for use in Russia (includes backlight cable and keyboard cable)

716747-261 Keyboard with backlight for use in Bulgaria (includes backlight cable and keyboard cable)
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Spare part number Description

716747-271 Keyboard with backlight for use in Romania (includes backlight cable and keyboard cable)

716747-281 Keyboard with backlight for use in Thailand (includes backlight cable and keyboard cable)

716747-291 Keyboard with backlight for use in Japan (includes backlight cable and keyboard cable)

716747-A41 Keyboard with backlight for use in Belgium (includes backlight cable and keyboard cable)

716747-AB1 Keyboard with backlight for use in Taiwan (includes backlight cable and keyboard cable)

716747-AD1 Keyboard with backlight for use in South Korea (includes backlight cable and keyboard cable)

716747-B31 Keyboard with backlight for use in the Netherlands (includes backlight cable and keyboard cable)

716747-B71 Keyboard with backlight for use in Sweden and Finland (includes backlight cable and
keyboard cable)

716747-BA1 Keyboard with backlight for use in Slovenia (includes backlight cable and keyboard cable)

716747-BB1 Keyboard with backlight for use in Israel (includes backlight cable and keyboard cable)

716747-BG1 Keyboard with backlight for use in Switzerland (includes backlight cable and keyboard cable)

716747-D61 Keyboard with backlight for use in India (includes backlight cable and keyboard cable)

716747-DB1 Keyboard with backlight for use in Canada (includes backlight cable and keyboard cable)

716747-DD1 Keyboard with backlight for use in Canada (includes backlight cable and keyboard cable)

716747-FL1 Keyboard with backlight for use in the Czech Republic and Slovakia (includes backlight cable and
keyboard cable)

716747-FP1 Keyboard with backlight for use in Northwest Africa (includes backlight cable and keyboard cable)

717379-001 WLAN Intel Dual Band Wireless-N 7260AN 802.11 a/b/g/n (2x2) WiFi + BT 4.0 combo

717380-001 WLAN Intel Dual Band Wireless-N 7260NB 802.11 a/b/g/n (2x2) WiFi 

740011-001 WWAN HP lt4111 LTE/EV-DO/HSPA+ Mobile Broadband Module (for use in the United States
and Canada) 

747833-001 WLAN Intel Dual Band Wireless-N 7260AN 802.11 a/b/g/n (2x2) WiFi + BT 4.0 combo (for use
in Indonesia)

753650-001 WWAN HP hs3110 HSPA+ Mobile Broadband 

753713-001 Service door (includes 4 captive retention screws and 2 rubber feet)

753714-001 Hinge cover (includes hinge cap, WWAN antenna cables and transceivers, and WWAN antenna
cable shield)

753715-001 Top cover (includes display lid switch actuator magnets, orientation lock switch actuator, power
switch actuator, TouchPad, and TouchPad cable)

753716-001 Fan/heat sink assembly (includes replacement thermal material)

753717-001 NFC board (includes cable)

753718-001 Power button board (includes cable)

753719-001 Speaker Kit (includes left and right speakers and cables)
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Spare part number Description

753720-001 11.6-in, AntiGlare (1366×768), HD, UWVA display assembly (includes display hinge,
microphones, webcamera, and Windows button)

753721-001 Base enclosure (includes battery release latch, NFC board antenna cable, power connector cover,
and RJ-45 jack cover)

753723-001 System board equipped with anIntel Dual Core i3-4010U 1.7-GHz processor, 1600-MHz front-side
bus (FSB), 3 MB L3 cache, 15 W and the standard operating system (includes processor and
replacement thermal material)

753723-501 System board equipped with anIntel Dual Core i3-4010U 1.7-GHz processor, 1600-MHz front-side
bus (FSB), 3 MB L3 cache, 15 W and the Windows 8.1.1 Standard operating system (includes
processor and replacement thermal material)

753723-601 System board equipped with anIntel Dual Core i3-4010U 1.7-GHz processor, 1600-MHz front-side
bus (FSB), 3 MB L3 cache, 15 W and the Windows 8.1.1 Professional operating system (includes
processor and replacement thermal material) 

753724-001 System board equipped with an Intel Dual Core i5-4200U 1.6-GHz processor (turbo up to 2.6-
GHz), 1600-MHz FSB, 3- MB L3 cache, 15 W and the standard operating system (includes
processor and replacement thermal material)

753724-501 System board equipped with an Intel Dual Core i5-4200U 1.6-GHz processor (turbo up to 2.6-
GHz), 1600-MHz FSB, 3- MB L3 cache, 15 W and the Windows 8.1.1 Standard operating system
(includes processor and replacement thermal material)

753724-601 System board equipped with an Intel Dual Core i5-4200U 1.6-GHz processor (turbo up to 2.6-
GHz), 1600-MHz FSB, 3- MB L3 cache, 15 W and the Windows 8.1 Professional operating system
(includes processor and replacement thermal material)

753725-001 System board equipped with an Intel Dual Core i5-4300U 1.9-GHz processor (turbo up to 2.90-
GHz), 1600-MHz FSB, 3-MB L3 cache, 15 W, and the Standard operating system (includes
processor and replacement thermal material)

753725-501 System board equipped with an Intel Dual Core i5-4300U 1.9-GHz processor (turbo up to 2.90-
GHz), 1600-MHz FSB, 3-MB L3 cache, 15 W, and the Windows 8.1 Standard operating system
(includes processor and replacement thermal material)

753725-601 System board equipped with an Intel Dual Core i5-4300U 1.9-GHz processor (turbo up to 2.90-
GHz), 1600-MHz FSB, 3-MB L3 cache, 15 W, and the Windows 8.1 Professional operating system
(includes processor and replacement thermal material)

753726-001 System board equipped with anIntel Dual Core iIntel Dual Core i7-4600U 2.1-GHz processor (turbo
up to 3.3-GHz), 1600-MHz FSB, 4- MB L3 cache, 15 W and the Standard operating system
(includes processor and replacement thermal material)

753726-501 System board equipped with anIntel Dual Core iIntel Dual Core i7-4600U 2.1-GHz processor (turbo
up to 3.3-GHz), 1600-MHz FSB, 4- MB L3 cache, 15 W and the Windows 8.1 Standard operating
system (includes processor and replacement thermal material)

753726-601 System board equipped with anIntel Dual Core iIntel Dual Core i7-4600U 2.1-GHz processor (turbo
up to 3.3-GHz), 1600-MHz FSB, 4- MB L3 cache, 15 W and the Windows 8.1 Professional
operating system (includes processor and replacement thermal material)

753728-001 128-GB solid-state drive

753729-001 256-GB solid-state drive

753730-001 180-GB solid-state drive

753731-001 Screw Kit
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4 Removal and replacement
procedures preliminary
requirements

Tools required
You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Magnetic screwdriver

● Phillips P0 and P1 screwdrivers

Service considerations
The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use
care when handling the plastic
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Cables and connectors

CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with
extreme care; these cables tear easily.

Drive handling

CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

Avoid exposing an internal hard drive to products that have magnetic fields, such as monitors or
speakers.

Avoid exposing an internal hard drive to products that have magnetic fields, such as monitors or
speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt silicon
junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static safe
materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive must be
worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastics Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V

26 Chapter 4   Removal and replacement procedures preliminary requirements



5 Removal and replacement
procedures for Customer Self-
Repair parts

NOTE: The Customer Self-Repair program is not available in all locations. Installing a part not
supported by the Customer Self-Repair program may void your warranty. Check your warranty to
determine if Customer Self-Repair is supported in your location.

Component replacement procedures
NOTE: Please read and follow the procedures described here to access and replace Customer Self-
Repair parts successfully.

NOTE: Details about your computer, including model, serial number, product key, and length of
warranty, are on the service tag at the bottom of your computer.

This chapter provides removal and replacement procedures for Customer Self-Repair parts.

There are as many as 11 screws that must be removed, replaced, and/or loosened when servicing
Customer Self-Repair parts. Make special note of each screw size and location during removal
and replacement.
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Battery

Description Spare part number

6 cell, 44-Wh, 1.98-Ah, Li-ion battery 698943-001

Before disassembling the computer, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

Remove the battery:

1. Turn the computer upside down on a flat surface.

2. Slide the battery release latch (1) to release the battery.

3. Pivot the battery up and then remove the battery from the computer (2).

To insert the battery:

1. Turn the computer upside down on a flat surface.

2. Insert the battery (1) at a 45-degree angle into the battery bay until it is seated.
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3. Pivot the battery downwards (2) until it is seated. The battery release latch automatically locks the
battery into place.
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Service door

Description Spare part number

Service door (includes 4 captive retention screws and 2 rubber feet) 753713-001

Before removing the service door, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 28).

Remove the service door:

1. Turn the computer upside down, with the front toward you.

2. Press on the memory card bezel (1) once to release the bezel, and then press on the bezel again
to remove the bezel.

3. Remove the two large rubber screw covers (2).

4. Remove the two Phillips M2.0×6.5 screws (3) that secure the service door to the computer.

5. Remove the two small rubber screw covers (4).

The large and small rubber screw covers are included in the Plastics/Rubber Kit, spare part
number 753713-001.

6. Remove the two Phillips M2.0×8.5 screws (5) that secure the service door to the computer.

7. Loosen the four captive Phillips screws (1) that secure the service door to the computer.
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8. Lift the front edge of the service door (2) until the cover detaches from the computer, and then
remove the service door (3) from the computer.

Reverse this procedure to install the service door.
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WWAN module

Description Spare part number

HP lt4112 LTE/HSPA+ Mobile Broadband Module (Europe and Asia Pacific) 704030-001

HP lt4111 LTE/EV-DO/HSPA+ Mobile Broadband Module (for use in the United States and
Canada)

740011-001

HP hs3110 HSPA+ Mobile Broadband 753650-001

CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless devices
in your country or region. If you replace the module and then receive a warning message, remove the
module to restore device functionality, and then contact technical support.

Before removing the WWAN module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 28).

5. Remove the service door (see Service door on page 30).

Remove the WWAN module:

1. Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.

NOTE: The WWAN antenna cable labeled MAIN connects to the WWAN module “Main”
terminal. The WWAN antenna cable labeled AUX connects to the WWAN module “Aux”
terminal.

2. Remove the Phillips M2.0×3.0 screw (2) that secures the WWAN module to the computer. (The
WWAN module tilts up.)
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3. Remove the WWAN module (3) by pulling the module away from the slot at an angle.

NOTE: If the WWAN antenna cables are not connected to the terminals on the WWAN module, the
protective sleeves must be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WWAN module.
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WLAN module

Description Spare part number

Intel Dual Band Wireless-AC 7260 802.11 ac (2x2) WiFi + BT 4.0 combo 710663-001

Intel Dual Band Wireless-N 7260AN 802.11 a/b/g/n (2x2) WiFi + BT 4.0 combo 717379-001

Intel Dual Band Wireless-N 7260NB 802.11 a/b/g/n (2x2) WiFi 717380-001

Intel Dual Band Wireless-N 7260AN 802.11 a/b/g/n (2x2) WiFi + BT 4.0 combo (for use in
Indonesia)

747833-001

CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless devices
in your country or region. If you replace the module and then receive a warning message, remove
the module to restore device functionality, and then contact technical support.

Before removing the WLAN module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 28).

5. Remove the service door (see Service door on page 30).

Remove the WLAN module:

1. Disconnect the WLAN connector from the computer.

2. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The WLAN antenna cable labeled MAIN connects to the WLAN module “Main”
terminal. The WLAN antenna cable labeled AUX connects to the WLAN module “Aux” terminal.

3. Remove the  Phillips M2.0×2.5 screw (2) that secures the WLAN module to the system board.
(The WLAN module tilts up.)
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4. Remove the WLAN module (3) by pulling the module away from the connection at an angle.

NOTE: If the WLAN antennas are not connected to the terminals on the WLAN module, the protective
sleeves should be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WLAN module.

Solid-state drive

Description Spare part number

256-GB 753729-001
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Description Spare part number

128-GB 753728-001

180-GB 753730-001

Before removing the solid-state drive, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 28).

5. Remove the service door (see Service door on page 30).

Remove the solid-state drive:

1. Remove the Phillips M2.0×3.0 screw (1) that secures the solid-state drive to the computer. (The
solid-state drive tilts up.)
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2. Remove the solid-state drive (2) by pulling the drive away from the slot at an angle.

Reverse this procedure to install the solid-state drive.

Memory module

Description Spare part number

4 GB memory module (PC3, 12800, 1600-MHz) 691740-001

8 GB memory module PC3L 12800 1600Mhz Shared 693374-001

Before removing a memory module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.
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4. Remove the battery (see Battery on page 28).

5. Remove the service door (see Service door on page 30).

Remove the memory module:

NOTE: Note the location of the memory module. If you are replacing it, install the new memory
module in the same slot.

1. Spread the two retaining tabs (1) on each side of the memory module slot to release
the memory module. (The memory module tilts up.)

2. Remove the memory module (2) by pulling it away from the slot at a 45 degree angle.

Reverse this procedure to install the memory module.
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6 Removal and replacement
procedures for Authorized Service
Provider parts

CAUTION: Components described in this chapter should only be accessed by an authorized service
provider. Accessing these parts can damage the computer or void the warranty.

Component replacement procedures
NOTE: Details about your computer, including model, serial number, product key, and length of
warranty, are on the service tag at the bottom of your computer. See Bottom on page 11 for details.

This chapter provides removal and replacement procedures for Authorized Service Provider only parts.

There are as many as 62 screws that must be removed, replaced, and/or loosened when servicing
Authorized Service Provider only parts. Make special note of each screw size and location during
removal and replacement.
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NFC board

Description Spare part number

NFC board (includes NFC board cable) 753717-001

Before removing the NFC board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 28).

5. Remove the service door (see Service door on page 30).

Remove the NFC board:

1. Disconnect the NFC antenna cable (1) from the NFC board.

The NFC antenna cable is included in the Top cover spare part kit, spare part number .

2. Release the zero insertion force (ZIF) connector (2) to which the NFC board cable is attached,
and then disconnect the NFC board cable from the system board.

3. Remove the Phillips M1.5×2.0 screw (3) that secures the NFC board to the Top cover. (The NFC
board cable is attached to the Top cover with double-sided tape.)

4. Remove the NFC board (4) and cable.

Reverse this procedure to install the NFC board.
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Keyboard

NOTE: The keyboard spare part kit includes a backlight cable, keyboard, and keyboard cable.

For use in country/region Spare part number For use in country/region Spare part number

For use in Belgium 716747-A41 For use in Norway 716747-091

For use in Brazil 716747-201 For use in Northwest Africa 716747-FP1

For use in Bulgaria 716747-261 For use in Portugal 716747-131

For use in Canada 716747-DB1 For use in Romania 716747-271

For use in the Czech Republic
and Slovakia

716747-FL1 For use in Russia 716747-251

For use in Denmark 716747-081 For use in Saudi Arabia 716747-171

For use in France 716747-051 For use in Slovenia 716747-BA1

For use in Germany 716747-041 For use in South Korea 716747-AD1

For use in Greece 716747-151 For use in Spain 716747-071

For use in Hungary 716747-211 For use in Sweden and Finland 716747-B71

For use in Iceland 716747-DD1 For use in Switzerland 716747-BG1

For use in India 716747-D61 For use in Taiwan 716747-AB1

For use in Israel 716747-BB1 For use in Thailand 716747-281

For use in Italy 716747-061 For use in Turkey 716747-141

For use in Japan 716747-291 For use in the United Kingdom
and Singapore

716747-031

For use in Latin America 716747-161 For use in the United States 716747-001

For use in the Netherlands 716747-B31  

Before removing the keyboard, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 28).

5. Remove the service door (see Service door on page 30).
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Remove the keyboard:

1. Loosen the 2 captive screws that secure the keyboard to the computer.

2. Rest and secure the computer on its left side.

3. Partially open the computer.

4. Insert a screw driver or similar thin tool into the keyboard release hole near the fan, and then
press on the back of the keyboard until the keyboard disengages from the computer.

5. Turn the computer right-side up with the front toward you.
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6. Open the computer.

7. Lift the rear edge of the keyboard, and then swing the keyboard up and forward until it rests
upside down on the palm rest.

8. Release the ZIF connector (1) to which the backlight cable is attached, and then disconnect the
backlight cable (2) from the system board.

9. Release the ZIF connector (3) to which the keyboard cable is attached, and then disconnect the
keyboard cable (4) from the system board.
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10. Remove the keyboard (5).

Reverse this procedure to install the keyboard.
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Top cover

Description Spare part number

Top cover with TouchPad (includes battery release latch, NFC board antenna cable, power
connector cover, and RJ-45 jack cover)

753715-001

Before removing the Top cover, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 28).

5. Remove the service door (see Service door on page 30).

6. Remove the keyboard (see Keyboard on page 41).

Remove the Top cover:

1. Remove the two Phillips M2.0×4.3 screws that secure the Top cover to the computer.

2. Close the computer.

3. Turn the computer upside down, with the rear toward you.

4. Disconnect the microphone cable (1) from the system board.
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5. Release the tape (2) and (3) that secures the WWAN antenna cables and the WLAN antenna
cables.

6. Remove the five Torx T8M2.0×5.65 screws (1) and the Torx T8M2.0×2.5 screw (2) that secure
the Top cover to the computer.
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7. Remove the Top cover.

Reverse this procedure to install the Top cover.
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Speakers

Description Spare part number

Front speakers (includes left and right speakers, cables, and 4 rubber isolators) 753719-001

Before removing the speakers, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 28), and then remove the following components:

a. service door (see Service door on page 30)

b. Keyboard (see Keyboard on page 41)

c. Top cover (see Top cover on page 45)

Remove the speakers:

1. Disconnect the speaker cables (1) from the system board.

2. Release the left speaker cable (2) from the clips built into the top cover.

3. Remove the three Phillips M2.0×3.0 broad head screws (3) that secure the speakers to the
top cover.
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4. Remove the speakers (4).

Reverse this procedure to install the speakers.
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Power Button board

Description Spare part number

Power Button board (includes cable) 753718-001

Before removing the button board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 28), and then remove the following components:

a. Service door (see Service door on page 30)

b. Keyboard (see Keyboard on page 41)

c. Top cover (see Top cover on page 45)

d. Right speaker (see Speakers on page 48)

Remove the button board:

1. Turn the computer right side up, with the front toward you.

2. Open the computer.

3. Release the ZIF connector (1) to which the button board cable is attached, and then disconnect
the button board cable (2) from the system board.

4. Close the computer.

5. Turn the computer upside down, with the rear toward you.
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6. Detach the button board (1) from the top cover. (The button board cable is attached to the the top
cover with double-sided tape.)

7. Remove the Phillips M2.0×3.0 screw (2) that secures the button board to the top cover.

8. Remove the button board (3).

Reverse this procedure to install the button board.

RTC battery

Description Spare part number

RTC battery (includes cable and double-sided adhesive) 716742-001

Before removing the RTC battery, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 28), and then remove the following components:

a. Service door (see Service door on page 30)

b. Keyboard (see Keyboard on page 41)

c. Top cover (see Top cover on page 45)

Remove the RTC battery:

1. Disconnect the RTC battery cable (1) from the system board.

Component replacement procedures 51



2. Detach the RTC battery (2) from the top cover. (The RTC battery is attached to the system board
with double-sided tape.)

3. Remove the RTC battery.

Reverse this procedure to install the RTC battery.
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Fan/heat sink assembly

Description Spare part number

Fan/heat sink assembly (includes replacement thermal material) 753716-001

Before removing the fan/heat sink assembly, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 28), and then remove the following components:

a. Service door (see Service door on page 30)

b. Keyboard (see Keyboard on page 41)

c. Top cover (see Top cover on page 45)

Remove the fan/heat sink assembly:

1. Disconnect the fan cable (1) from the system board.

2. Following the 1, 2, 3, 4 sequence stamped into the fan/heat sink assembly, loosen the four
captive Phillips M2.0×6.5 screws (2) that secure the fan/heat sink assembly to the system board.

3. Remove the fan/heat sink assembly (3).

NOTE: Due to the adhesive quality of the thermal material located between the fan/heat sink
assembly and the system board components, it may be necessary to move the fan/heat sink
assembly from side to side to detach it.
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NOTE: The thermal material must be thoroughly cleaned from the surfaces of the fan/heat sink
assembly and the processor each time the fan/heat sink assembly is removed. Replacement thermal
material is included with the fan/heat sink assembly and system board spare part kits. Thermal paste is
used on the processor (1) and the section of the fan/heat sink assembly (2) that services it.

Reverse this procedure to install the fan/heat sink assembly.
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System board

Description Spare part number

Equipped with an Intel Dual Core iIntel Dual Core i7-4600U 2.1-GHz processor (turbo up to 3.3-
GHz), 1600-MHz FSB, 4- MB L3 cache, 15 W, and the Standard operating system

753726-001

Equipped with an Intel Dual Core i7-3687U 2.10-GHz (turbo up to 3.30-GHz), 1600-MHz FSB,
4.00-MB L3 cache, 17 W, and the Windows 8.1 Standard operating system

753726-501

Equipped with an Intel Dual Core Intel Dual Core i7-4600U 2.1-GHz processor (turbo up to 3.3-
GHz), 1600-MHz FSB, 4- MB L3 cache, 15 W, and the Windows 8 Professional operating system

753726-601

Equipped with an Intel Dual Core i5-3437U 1.90-GHz (turbo up to 2.90-GHz), 1600-MHz FSB,
3.00-MB L3 cache, 17 W, and the Standard operating system

753725-001

Equipped with an Intel Dual Core i5-4300U 1.9-GHz processor (turbo up to 2.90- GHz), 1600-
MHz FSB, 3-MB L3 cache, 15 W, and the Windows 8 Standard operating system

753725-501

Equipped with an Intel Dual Core i5-4300U 1.9-GHz processor (turbo up to 2.90- GHz), 1600-
MHz FSB, 3-MB L3 cache, 15 W, and the Windows 8 Professional operating system

753725-601

Equipped with an Intel Dual Core i5-4200U 1.6-GHz processor (turbo up to 2.6-GHz), 1600-MHz
FSB, 3- MB L3 cache, 15 W and the Standard operating system

753724-001

Equipped with an Intel Dual Core i5-4200U 1.6-GHz processor (turbo up to 2.6-GHz), 1600-MHz
FSB, 3- MB L3 cache, 15 and the Windows 8 Standard operating system

753724-501

Equipped with an Intel Dual Core i5-4200U 1.6-GHz processor (turbo up to 2.6-GHz), 1600-MHz
FSB, 3- MB L3 cache, 15 and the Windows 8 Professional operating system

753724-601

Equipped with an Intel Dual Core i3-4010U 1.7-GHz processor, 1600-MHz front-side bus (FSB), 3
MB L3 cache, 15 W and the Standard operating system

753723-001

Equipped with an Intel Dual Core i3-4010U 1.7-GHz processor, 1600-MHz front-side bus (FSB), 3
MB L3 cache, 15 W and the Windows 8 Standard operating system

753723-501

Equipped with an Intel Dual Core i3-4010U 1.7-GHz processor, 1600-MHz front-side bus (FSB), 3
MB L3 cache, 15 W and the Windows 8 Professional operating system

753723-601

Before removing the system board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 28), and then remove the following components:

a. Service door (see Service door on page 30)

b. WWAN module (see WWAN module on page 32)

c. WLAN module (see WLAN module on page 34)

d. Solid-state drive (see Solid-state drive on page 35)

e. Keyboard (see Keyboard on page 41)
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f. Top cover (see Top cover on page 45)

g. Right speaker (see Speakers on page 48)

h. Fan/heat sink assembly (see Fan/heat sink assembly on page 53)

NOTE: When replacing the system board, be sure that the following components are removed from
the defective system board and installed on the replacement system board:

● Memory module (see Memory module on page 37)

● RTC battery (see RTC battery on page 51)

Remove the system board:

1. Turn the computer right side up, with the front toward you.

2. Open the computer.

3. Release the ZIF connector (1) to which the TouchPad cable is attached, and then disconnect the
TouchPad cable (2) from the system board.

4. Disconnect the display panel cable (1) from the system board.

5. Remove the Phillips M2.0×2.5 screw (2) that secures the system board to the top cover.
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6. Remove the system board (3).

Reverse this procedure to install the system board.
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Hinge cover

Description Spare part number

Hinge cover (includes hinge cap, WWAN antenna cables and transceivers, and WWAN antenna
shield)

753714-001

Before removing the hinge cover, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 28), and then remove the following components:

a. Service door (see Service door on page 30)

b. WWAN module (see WWAN module on page 32)

c. WLAN module (see WLAN module on page 34)

d. Solid-state drive (see Solid-state drive on page 35)

e. Keyboard (see Keyboard on page 41)

f. Top cover (see Top cover on page 45)

g. Fan/heat sink assembly (see Fan/heat sink assembly on page 53)

h. System board (see System board on page 55)

Remove the hinge cover:

1. Remove the shield (1) that secures the WWAN antenna cables (2) in the routing channel built
into the top cover.
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2. Remove the six Phillips M2.0×2.5 screws (3) that secure the hinge cover to the top cover.

3. Turn the computer right side up, with the front toward you.

4. Open the computer.

5. Rotate the display assembly (1) clockwise until it is perpendicular to the computer body.

6. Detach the left (2) and right edges of the hinge cover from the computer.

7. Remove the hinge cover (3) by sliding it away from the computer.

8. Remove the hinge cap (4).

Reverse this procedure to install the hinge cover and hinge cap.
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Display assembly

Description Spare part number

Display Hinge up 11.6 HD AG UWVA 753720-001

Before removing the display assembly, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 28), and then remove the following components:

a. Service door (see Service door on page 30)

b. WWAN module (see WWAN module on page 32)

c. WLAN module (see WLAN module on page 34)

d. Solid-state drive (see Solid-state drive on page 35)

e. Keyboard (see Keyboard on page 41)

f. Top cover (see Top cover on page 45)

g. Fan/heat sink assembly (see Fan/heat sink assembly on page 53)

h. System board (see System board on page 55)

i. Hinge cover and hinge cap (see Hinge cover on page 58)

Remove the display assembly:

1. Remove the two Phillips M2.0×5.0 screws (1) that secure the display assembly to the top cover.
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2. Slide the display assembly (2) away from the top cover and remove it.

Reverse this procedure to install the display assembly.
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7 Backup and recovery

Windows 8.1
To protect your information, use Windows backup and restore utilities to back up individual files and
folders, back up your entire hard drive, create system repair media (select models only) by using the
installed optical drive (select models only) or an optional external optical drive, or create system restore
points. In case of system failure, you can use the backup files to restore the contents of your computer.

From the Start screen, type restore, click Everywhere, and change to Settings, and then select
from the list of displayed options.

NOTE: For detailed instructions on various backup and restore options, perform a search for these
topics in Windows Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them for
later use.

NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. For more information, see Windows Help and Support.

Backing up your information

Recovery after a system failure is as good as your most recent backup. You should create system repair
media and your initial backup immediately after initial system setup. As you add new software and
data files, you should continue to back up your system on a regular basis to maintain a reasonably
current backup. The system repair media (select models only) are used to start up (boot) the computer
and repair the operating system in case of system instability or failure. Your initial and subsequent
backups allow you to restore your data and settings if a failure occurs.

For more information on the Windows backup features, see Windows Help and Support.

Performing a system recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Automatic Repair to fix problems that
might prevent Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
media you previously created (select models only), you must purchase Windows operating system
media to reboot the computer and repair the operating system. For additional information, see Using
Windows operating system media (purchased separately) on page 64.
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Using the Windows recovery tools

To recover information you previously backed up, see Windows Help and Support for steps on
restoring files and folders.

To recover your information using Automatic Repair, follow these steps:

CAUTION: Some Startup Repair options will completely erase and reformat the hard drive. All files
you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Recovery Image partition and the Windows partition.

From the Start screen, type file, and then click File Explorer.

– or –

From the Start screen, type pc, and then select This PC.

NOTE: If the Windows partition and the Recovery Image partition are not listed, you must
recover your operating system and programs using the Windows operating system DVD and the
Driver Recovery media (both purchased separately). For additional information, see Using
Windows operating system media (purchased separately) on page 64.

3. If the Windows partition and the Recovery Image partition are listed, restart the computer by
pressing and holding the shift key while clicking Restart.

4. Select Troubleshoot, select Advanced Options, and then select Startup Repair.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Windows Help and Support.

Using f11 recovery tools

CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
that you have created and any software that you have installed on the computer are permanently
removed. The f11 recovery tool reinstalls the operating system and HP programs and drivers that were
installed at the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:

1. If possible, back up all personal files.

2. If possible, check for the presence of the Recovery Image partition: From the Start screen, type pc,
and then select This PC.

NOTE: If the Recovery Image partition is not listed, you must recover your operating system and
programs using the Windows operating system media and the Driver Recovery media (both
purchased separately). For additional information, see Using Windows operating system media
(purchased separately) on page 64.

3. If the Recovery Image partition is listed, restart the computer, and then press esc while the “Press
the ESC key for Startup Menu” message is displayed at the bottom of the screen.
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4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using Windows operating system media (purchased separately)

To order a Windows operating system DVD, contact support. See the Worldwide Telephone Numbers
booklet included with the computer. You can also find contact information from the HP website. Go to
http://www.hp.com/support, select your country or region, and follow the on-screen instructions. .

CAUTION: Using a Windows operating system media completely erases hard drive contents and
reformats the hard drive. All files that you have created and any software that you have installed on the
computer are permanently removed. When reformatting is complete, the recovery process helps you
restore the operating system, as well as drivers, software, and utilities.

To initiate a full install of the operating system using a Windows operating system DVD:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Insert the Windows operating system DVD into the optical drive, and then restart the computer.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

After the installation is completed:

1. Eject the Windows operating system media and then insert the Driver Recovery media.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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Using Windows Refresh or Windows Reset

When your computer is not working properly and you need to regain system stability, the Windows
Refresh option allows you to start fresh and keep what is important to you.

The Windows Reset option allows you to perform detailed reformatting of your computer, or remove
personal information before you give away or recycle your computer. For more information on these
features, see Windows Help and Support.

Using HP Software Setup

HP Software Setup can be used to reinstall drivers or select software that has been corrupted or deleted
from the system.

1. From the Start screen, type HP Software Setup.

2. Open HP Software Setup.

3. Follow the on-screen directions to reinstall drivers or select software.
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Windows 7
Your computer includes HP and Windows tools to help you safeguard your information and retrieve it if
you ever need to. These tools will help you return your computer to a proper working state, all with
simple steps. This section provides information about the following processes:

● Creating recovery media and backups

● Restoring and recovering your system

Creating recovery media and backups

Recovery after a system failure is only as good as your most recent backup.

1. After you successfully set up the computer, create HP Recovery media. This step creates a
Windows 7 operating system DVD and a Driver Recovery DVD. The Windows DVD can be used
to reinstall the original operating system in cases where the hard drive is corrupted or has been
replaced. The Driver Recovery DVD installs specific drivers and applications. See Creating
recovery media with HP Recovery Disc Creator (select models only) on page 66.

2. Use Windows Backup and Recovery tools to perform the following:

● Back up individual files and folders

● Back up your entire hard drive (select models only)

● Create system repair discs (select models only) with the installed optical drive (select models
only) or an optional external optical drive

● Create system restore points

NOTE: This guide describes an overview of backing up, restoring, and recovering options. For more
details about the tools provided, see Help and Support. To access Help and Support, select Start >
Help and Support.

NOTE: HP recommends that you print the recovery procedures and save them for later use, in case of
system instability.

In case of system failure, you can use the backup files to restore the contents of your computer. See
Backing up your information on page 67.

Guidelines

● When creating recovery media or backing up to discs, use any of the following types of discs
(purchased separately): DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use
will depend on the type of optical drive you are using.

● Be sure that the computer is connected to AC power before you start the recovery media creation
process or the backup process.

Creating recovery media with HP Recovery Disc Creator (select models only)

HP Recovery Disc Creator is a software program that offers an alternative way to create recovery
media. After you successfully set up the computer, you can create recovery media using HP Recovery
Disc Creator. This recovery media allows you to reinstall your original operating system as well as
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select drivers and applications if the hard drive becomes corrupted. HP Recovery Disc Creator can
create two kinds of recovery DVDs:

● Windows 7 operating system DVD—Installs the operating system without additional drivers or
applications.

● Driver Recovery DVD—Installs specific drivers and applications only, in the same way that the HP
Software Setup utility installs drivers and applications.

Creating recovery media

NOTE: The Windows 7 operating system DVD can be created only once. Thereafter, the option to
create that media will not be available after you create a Windows DVD.

To create the Windows DVD:

1. Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2. Select Windows disk.

3. From the drop-down menu, select the drive for burning the recovery media.

4. Click the Create button to start the burning process.

After the Windows 7 operating system DVD has been created, create the Driver Recovery DVD:

1. Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2. Select Driver disk.

3. From the drop-down menu, select the drive for burning the recovery media.

4. Click the Create button to start the burning process.

Backing up your information

You should create system repair media and your initial backup immediately after initial system setup.
As you add new software and data files, you should continue to back up your system on a regular
basis to maintain a reasonably current backup. You should also create Windows system repair media
(select models only) which can be used to start up (boot) the computer and repair the operating system
in case of system instability or failure. Your initial and subsequent backups allow you to restore your
data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated directories.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

● When backing up to discs, number each disc after removing it from the drive.

NOTE: For detailed instructions on various backup and restore options, perform a search for these
topics in Help and Support. To access Help and Support, select Start > Help and Support.
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NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support. To access Help and Support, select
Start > Help and Support.

To create a backup using Windows Backup and Restore:

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create system repair media (select models only).

Performing a system recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

● f11 recovery tools (select models only): You can use the f11 recovery tools to recover your original
hard drive image. The image includes the Windows operating system and software programs
installed at the factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
media you previously created (select models only), you must purchase Windows 7 operating system
media to reboot the computer and repair the operating system. For additional information, see Using
Windows 7 operating system media on page 70.
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Using the Windows recovery tools

Using the Windows recovery tools, you can:

● Recover individual files

● Restore the computer to a previous system restore point

● Recover information using recovery tools

NOTE: For detailed instructions on various recovery and restore options, perform a search for these
topics in Help and Support. To access Help and Support, select Start > Help and Support.

NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support. To access Help and Support, select
Start > Help and Support.

To recover information you previously backed up:

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to recover your system settings, your computer (select models
only), or your files.

To recover your information using Startup Repair, follow these steps:

CAUTION: Some Startup Repair options will completely erase and reformat the hard drive. All files
you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition.

To check for the Windows partition, select Start > Computer.

NOTE: If the Windows partition is not listed, you must recover your operating system and
programs using the Windows 7 operating system DVD and the Driver Recovery media. For
additional information, see Using Windows 7 operating system media on page 70.

3. If the Windows partition is listed, restart the computer, and then press f8 before the Windows
operating system loads.

4. Select Startup Repair.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, select Start >
Help and Support.
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Using f11 recovery tools (select models only)

CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
that you have created and any software that you have installed on the computer are permanently
removed. The f11 recovery tool reinstalls the operating system and HP programs and drivers that were
installed at the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: click Start, right-click Computer,
click Manage, and then click Disk Management.

NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 7 operating system media and the Driver Recovery media. For
additional information, see Using Windows 7 operating system media on page 70.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press the
ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using Windows 7 operating system media

If you cannot use the recovery media you previously created using the HP Recovery Disc Creator (select
models only), you must purchase a Windows 7 operating system DVD to reboot the computer and
repair the operating system.

To order a Windows 7 operating system DVD, go to the HP website. For U.S. support, go to
http://www.hp.com/support. For worldwide support, go to http://welcome.hp.com/country/us/en/
wwcontact_us.html. You can also order the DVD by calling support. For contact information, see the
Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files that you have created and any software that you have installed on
the computer are permanently removed. When reformatting is complete, the recovery process helps you
restore the operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 7 operating system DVD:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 7 operating system DVD into the optical drive
before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.
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6. Select Repair your computer.

7. Follow the on-screen instructions.

After the repair is completed:

1. Eject the Windows 7 operating system DVD and then insert the Driver Recovery DVD.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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8 Computer Setup (BIOS) and
Advanced System Diagnostics
Windows 8.1

Using Computer Setup
Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of devices installed, the startup sequence of the
computer, and the amount of system and extended memory.

NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer
from operating properly.

Starting Computer Setup

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad or USB mouse) or the keyboard to
navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.

72 Chapter 8   Computer Setup (BIOS) and Advanced System Diagnostics Windows 8.1



To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes:

Click the Exit icon in the lower-left corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

● To save your changes and exit Computer Setup menus:

Click the Save icon in the lower-left corner of the screen, and then follow the on-screen
instructions.

– or –

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then
press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select File > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the
factory settings.

Updating the BIOS

Updated versions of the BIOS may be available on the HP website.

Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.
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Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing fn
+esc (if you are already in Windows) or by using Computer Setup.

1. Start Computer Setup.

2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

Downloading a BIOS update

CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download
and install a BIOS update only when the computer is connected to reliable external power using the AC
adapter. Do not download or install a BIOS update while the computer is running on battery power,
docked in an optional docking device, or connected to an optional power source. During the
download and installation, follow these instructions:

Do not disconnect power on the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Sleep.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. From the Start screen, select the HP Support Assistant app.

2. Select Updates and tune-ups, and then select Check for HP updates now.

3. At the download area, follow these steps:

a. Identify the BIOS update that is later than the BIOS version currently installed on your
computer. Make a note of the date, name, or other identifier. You may need this information
to locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

Make a note of the path to the location on your hard drive where the BIOS update is
downloaded. You will need to access this path when you are ready to install the update.

NOTE: NOTE: If you connect your computer to a network, consult the network administrator
before installing any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the
download is complete. If no instructions are displayed, follow these steps:

1. From the Start screen, type e, and then click File Explorer.

2. Double-click your hard drive designation. The hard drive designation is typically Local Disk (C:).
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3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains
the update.

4. Double-click the file that has an .exe extension (for example, filename.exe).

The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.

Using Advanced System Diagnostics
Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer hardware
is functioning properly. The following diagnostic tests are available in Advanced System Diagnostics:

● System Tune-Up—This group of additional tests checks your computer to make sure that the main
components are functioning correctly. System Tune-Up runs longer and more comprehensive tests
on memory modules, hard drive SMART attributes, the hard drive surface, the battery (and battery
calibration), video memory, and the WLAN module status.

● Start-up test—This test analyzes the main computer components that are required to start
the computer.

● Run-in test—This test repeats the start-up test and checks for intermittent problems that the start-up
test does not detect.

● Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move the
data to a good sector.

● Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

● Battery test—This test analyzes the condition of the battery and calibrates the battery if necessary.
If the battery fails the test, contact HP support to report the issue and purchase a
replacement battery.

● BIOS Management—You can update or rollback the version of the BIOS on the system. Do not
shut down or remove external power during the process. You will be given a confirmation
screen before your BIOS is modified. Select BIOS update, BIOS Rollback, or Back to
main menu.

You can view system information and error logs or select languages in the Advanced System
Diagnostics window.

To start Advanced System Diagnostics:

1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press f2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostics test while it is running, press esc.
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9 Windows 7 - Using Computer Setup
(BIOS) and HP PC Hardware
Diagnostics (UEFI)

Setup Utility, or Basic Input/Output System (BIOS), controls communication between all the input and
output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Setup Utility
(BIOS) includes settings for the types of devices installed, the startup sequence of the computer, and the
amount of system and extended memory.

Starting Setup Utility (BIOS)
▲ To start Setup Utility (BIOS), turn on or restart the computer, quickly press esc, and then press f10.

NOTE: Use extreme care when making changes in Setup Utility (BIOS). Errors can prevent the
computer from operating properly.

Updating the BIOS
Updated versions of the BIOS may be available on the HP website.

Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing fn
+esc (if you are already in Windows) or by using Setup Utility (BIOS).

1. Start Setup Utility (BIOS).

2. Use the arrow keys to select Main.

3. To exit Setup Utility (BIOS) without saving your changes, use the arrow keys to select Exit, select
Exit Discarding Changes, and then press enter.

4. Select Yes.
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Downloading a BIOS update

CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download
and install a BIOS update only when the computer is connected to reliable external power using the AC
adapter. Do not download or install a BIOS update while the computer is running on battery power,
docked in an optional docking device, or connected to an optional power source. During the
download and installation, follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Sleep or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Select Start > Help and Support > Maintain.

2. Follow the on-screen instructions to identify your computer and access the BIOS update you want
to download.

3. At the download area, follow these steps:

a. Identify the BIOS update that is later than the BIOS version currently installed on your
computer. Make a note of the date, name, or other identifier. You may need this information
to locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

Make a note of the path to the location on your hard drive where the BIOS update is
downloaded. You will need to access this path when you are ready to install the update.

NOTE: If you connect your computer to a network, consult the network administrator before
installing any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the
download is complete. If no instructions are displayed, follow these steps:

1. Open Windows Explorer by selecting Start > Computer.

2. Double-click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains
the update.

4. Double-click the file that has an .exe extension (for example, filename.exe).

The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.

Using HP PC Hardware Diagnostics (UEFI) (select
models only)

HP PC Hardware Diagnostics is a Unified Extensible Firmware Interface (UEFI) that allows you to run
diagnostic tests to determine if the computer hardware is functioning properly. The tool runs outside of
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the operating system to isolate hardware failures from issues that may be caused by the operating
system or other software components.

To start HP PC Hardware Diagnostics UEFI:

1. Turn on or restart the computer, quickly press esc, and then press f2.

The BIOS searches three places for the HP PC Hardware Diagnostics (UEFI) tools in the following
order:

a. Connected USB drive

NOTE: To download the HP PC Hardware Diagnostics (UEFI) tool to a USB drive, see
Downloading HP PC Hardware Diagnostics (UEFI) to a USB device on page 78.

b. Hard drive

c. BIOS

2. When the diagnostic tool opens, use the keyboard arrow keys to select the type of diagnostic test
you want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostic test while it is running, press esc.

Downloading HP PC Hardware Diagnostics (UEFI) to a USB device

NOTE: Instructions for downloading HP PC Hardware Diagnostics (UEFI) are provided in English
only.

1. Go to http://www.hp.com.

2. Point to Support, located at the top of the page, and then click Download Drivers.

3. In the text box, enter the product name, and then click Go.

– or –

Click Find Now to let HP automatically detect your product.

4. Select your computer model, and then select your operating system.

5. In the Diagnostic section, click HP UEFI Support Environment.

– or –

Click Download, and then select Run.

78 Chapter 9   Windows 7 - Using Computer Setup (BIOS) and HP PC Hardware Diagnostics (UEFI)

http://www.hp.com


10 Specifications

Computer specifications

 Metric U.S.

Dimensions

Width 28.5 cm 11.22 in

Depth 21.2 cm 8.35 in

Height 2.22 cm 0.87 in

Weight (equipped with 4096-MB memory module, solid-
state drive, 6-cell battery, and WLAN module)

1.40 kg 3.09 lbs

Input power

Operating voltage and current 18.5 Vdc @ 3.5 A – 65 W

19.5 Vdc @ 3.33 A – 65 W

19.5 Vdc @ 4.74 A – 90 W

19.5 Vdc @ 4.82 A – 90 W

19.5Vdc @ 2.31A – 45 W

Temperature

Operating 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity (noncondensing)

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating -15 m to 12,192 m -50 ft to 40,000 ft

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The device operates well within this
range of temperatures.

Computer specifications 79



11.6-inch UWVA display specifications

 Metric U.S.

Dimensions

Height 14.50 cm 5.71 in

Width 25.70 cm 10.12 in

Diagonal 29.40 cm 11.58 in

Number of colors Up to 16.8 million

Contrast ratio 200:1 (typical)

Brightness 400 nits (typical)

Pixel resolution

Pitch 0.197 × 0.197 mm

Format 1366 × 768

Configuration RGB vertical stripe

Backlight LED backlit

Character display 80 × 25

Total power consumption 3.46 W

Viewing angle ±65° horizontal, ±50° vertical (typical)

80 Chapter 10   Specifications



11 Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC, or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries
The following requirements are applicable to all countries and regions:

● The length of the power cord set must be at least 1.0 m (3.2 ft) and no more than 1.8 m (6 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.

Requirements for specific countries and regions

Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1
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Country/region Accredited agency Applicable note number

The People's Republic of China COC 5

South Korea EK 4

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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12 Recycling

When a non-rechargeable or rechargeable battery has reached the end of its useful life, do not dispose
of the battery in general household waste. Follow the local laws and regulations in your area for
battery disposal.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries. For more information about recycling programs, see the HP Web site at
http://www.hp.com/recycle.
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Top cover
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wireless light 9
wireless, product description 2
WLAN

spare part numbers 19, 20
WLAN module

removal 34
spare part numbers 17, 34

WWAN
spare part numbers 19, 20

WWAN module
removal 32
spare part numbers 17, 32

86 Index


	Product description
	External component identification
	Display
	Right side
	Left side
	TouchPad
	Lights
	Keys
	Bottom
	Rear

	Illustrated parts catalog
	Service tag
	Computer major components
	Miscellaneous parts
	Sequential part number listing

	Removal and replacement procedures preliminary requirements
	Tools required
	Service considerations
	Plastic parts
	Cables and connectors
	Drive handling

	Grounding guidelines
	Electrostatic discharge damage
	Packaging and transporting guidelines
	Workstation guidelines
	Equipment guidelines



	Removal and replacement procedures for Customer Self-Repair parts
	Component replacement procedures
	Battery
	Service door
	WWAN module
	WLAN module
	Solid-state drive
	Memory module


	Removal and replacement procedures for Authorized Service Provider parts
	Component replacement procedures
	NFC board
	Keyboard
	Top cover
	Speakers
	Power Button board
	RTC battery
	Fan/heat sink assembly
	System board
	Hinge cover
	Display assembly


	Backup and recovery
	Windows 8.1
	Backing up your information
	Performing a system recovery
	Using the Windows recovery tools
	Using f11 recovery tools
	Using Windows operating system media (purchased separately)
	Using Windows Refresh or Windows Reset
	Using HP Software Setup


	Windows 7
	Creating recovery media and backups
	Guidelines
	Creating recovery media with HP Recovery Disc Creator (select models only)
	Creating recovery media

	Backing up your information

	Performing a system recovery
	Using the Windows recovery tools
	Using f11 recovery tools (select models only)
	Using Windows 7 operating system media



	Computer Setup (BIOS) and Advanced System Diagnostics Windows 8.1
	Using Computer Setup
	Starting Computer Setup
	Navigating and selecting in Computer Setup
	Restoring factory settings in Computer Setup
	Updating the BIOS
	Determining the BIOS version
	Downloading a BIOS update


	Using Advanced System Diagnostics

	Windows 7 - Using Computer Setup (BIOS) and HP PC Hardware Diagnostics (UEFI)
	Starting Setup Utility (BIOS)
	Updating the BIOS
	Determining the BIOS version
	Downloading a BIOS update

	Using HP PC Hardware Diagnostics (UEFI) (select models only)
	Downloading HP PC Hardware Diagnostics (UEFI) to a USB device


	Specifications
	Computer specifications
	11.6-inch UWVA display specifications

	Power cord set requirements
	Requirements for all countries
	Requirements for specific countries and regions

	Recycling
	Index


<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Error
  /CompatibilityLevel 1.3
  /CompressObjects /Off
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJobTicket true
  /DefaultRenderingIntent /Default
  /DetectBlends false
  /DetectCurves 0.0000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams true
  /MaxSubsetPct 100
  /Optimize false
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts false
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Remove
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 150
  /ColorImageMinResolutionPolicy /Warning
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 150
  /GrayImageMinResolutionPolicy /Warning
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 550
  /MonoImageMinResolutionPolicy /Warning
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 2400
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /PDFX3:2002
  ]
  /PDFX1aCheck false
  /PDFX3Check true
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError false
  /PDFXTrimBoxToMediaBoxOffset [
    36.00000
    36.00000
    36.00000
    36.00000
  ]
  /PDFXSetBleedBoxToMediaBox false
  /PDFXBleedBoxToTrimBoxOffset [
    14.40000
    14.40000
    14.40000
    14.40000
  ]
  /PDFXOutputIntentProfile (ISO Coated v2 \050ECI\051)
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /CreateJDFFile false
  /Description <<
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000410064006f006200650020005000440046002065876863900275284e8e9ad88d2891cf76845370524d53705237300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef69069752865bc9ad854c18cea76845370524d5370523786557406300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /DAN <>
    /DEU <>
    /ESP <>
    /FRA <>
    /ITA <>
    /JPN <FEFF9ad854c18cea306a30d730ea30d730ec30b951fa529b7528002000410064006f0062006500200050004400460020658766f8306e4f5c6210306b4f7f75283057307e305930023053306e8a2d5b9a30674f5c62103055308c305f0020005000440046002030d530a130a430eb306f3001004100630072006f0062006100740020304a30883073002000410064006f00620065002000520065006100640065007200200035002e003000204ee5964d3067958b304f30533068304c3067304d307e305930023053306e8a2d5b9a306b306f30d530a930f330c8306e57cb30818fbc307f304c5fc59808306730593002>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020ace0d488c9c80020c2dcd5d80020c778c1c4c5d00020ac00c7a50020c801d569d55c002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken die zijn geoptimaliseerd voor prepress-afdrukken van hoge kwaliteit. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /PTB <>
    /SUO <>
    /SVE <>
    /ENU (Original PDF setting SheetSpotHiRes_1v4.joboptions from Ghent PDF Workgroup - 2008 Specifications version 4 \(PDF/X-1a:2001 compliant\) UNCHANGED but simply renamed for HPIE use.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /ConvertToCMYK
      /DestinationProfileName ()
      /DestinationProfileSelector /DocumentCMYK
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure false
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles false
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /DocumentCMYK
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /UseDocumentProfile
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [14173.229 14173.229]
>> setpagedevice


